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1. COURSE OUTLINE 

IRIS 101 

Objec�ves: 

• To	understand	access	and	navigate	the	IRIS	system	

Audience: All	IRIS	Users 

Pre-requisites: 

• Basic	Understanding	of	Microsoft	Windows	Navigation 

• Authorized	IRIS	Access 

Topics Covered: 

1. What	is	IRIS?	

2. How	to	Access	IRIS	

3. IRIS	Homepage	

4. Intro	to	iTRN,	iUAT	and	CIPR	

5. Logging	into	IRIS	

6. IRIS	Navigation	

6.1. IRIS	Responsibilities	and	how	do	they	work	

6.2. IRIS	Application	Toolbar	

6.3. Top	10	List	of	Most	Used	Functions	

6.4. Data	Entry	Mode	

6.5. Query	Mode	

6.6. List	of	Values	Button	and	its	Usage	

7. Submitting	Reports	

8. Viewing	and	Printing	Reports	

9. Setting	your	default	printer	

10. Setting	up	Favourites	in	the	Oracle	E-Business	Suite	Html	screen	

11. Exiting	Oracle	Applications	

12. Web	ADI	Overview	

13. Oracle	Journal	Entry	

Mul�ple Choice Mini Test 

This is an opportunity for the aEendee to evaluate the skills learned in the course and assess if 

they have achieved the course objec/ves.  

Cer/fica/on  

Next Recommended Course:  

IRIS Purchasing 101 
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2. WHAT IS IRIS? 

 

• IRIS stands for Integrated Resource Informa/on System.  

• Central Financial System used by the CIG. 

• Built on the Oracle E-Business plaGorm. 

• For more informa/on on Oracle, use Google. 

 

3. HOW TO ACCESS IRIS 

1. Start up the computer system and log on using your network password. 

2. Double click on the Internet Explorer icon. If it does not open in the IRIS Home Page, you 

must access it by entering the address as ‘iris.gov.ky’ and pressing <ENTER>. 
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4. INTRO TO ITRN, IUAT AND CIPR 

 

IRIS has 3 areas accessible by ALL users: 

Process 1.  iTRN – Training Environment 

a. This environment is used for training and prac/ce. 

Process 2. iUAT – User Acceptance Tes/ng 

a. This environment is used to test data fixes as well as future IRIS solu/ons. 

Process 3. IRIS LIVE (CIPR) – IRIS LIVE 

a. This environment is used for everyday government business.  

b. IT IS NOT TO BE USED FOR ANY SORT OF TESTING 

 

5. LOGGING INTO IRIS 

 

 

 

1. Enter User Name  

2. Enter Password 
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5.1 IRIS LANDING PAGE 
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6. IRIS NAVIGATION 

 

6.1 THE NAVIGATOR 

The Navigator window displays the name of the responsibility chosen.   

 

Use this window to perform a specific business flow. The Navigator window is always present 

during the session of Oracle and displays the name of the current responsibility in its /tle. 

 

 

 

The forms that can be navigated to are displayed in a naviga/on list on the leN side.  

 

The naviga/on list is organized much like the hierarchy of a file system; expand items that 

begin with a plus sign (+) to further sublevels un/l the form of interest is found. Sublevels 

appear indented below the items from which they are expanded. Items that are expanded are 

preceded by a minus sign (-). Expand no further when an item displays neither a plus or minus 

sign. 
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Each window opened requires a certain amount of compu�ng resources. If the 

computer is low on resources, select Tools from the toolbar then Close Other Forms to 

avoid was�ng resources. 

6.2 EXPANDING OR COLLAPSING THE NAVIGATION LIST 

To Expand an Item to its Next Sublevel: Double-click the item. 

• To open a level.  

 

To Collapse an Expanded Item: 

• Select the item and choose Collapse.   

 

To expand or Collapse Several Items at Once: 

• Expands all the sublevels of the currently selected item.  

• Expand all sublevels of all expandable items in the naviga/on list.  

• Collapses all currently expanded items in the naviga/on list.  
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6.3 IRIS USER TYPES 

User Type defines the level of access you have and the level of permissions to access certain 

parts of the system. 

 

 

 

 

6.4 IRIS APPLICATIONS TOOLBAR 

 

In addi/on to keyboard shortcuts, you can also invoke func/ons that are iden/cal to specific 

menu items by choosing buEons from the toolbar. The toolbar replicates many commonly 

used menu items to invoke their ac/ons quickly without having to search for them in the 

menu bar. 
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The toolbar is a collec/on of icon buEons. Each toolbar buEon performs a specific ac/on when 

chosen. 

 

Each toolbar buEon replicates a commonly used menu item. Depending on the context of the 

current field or window, a toolbar buEon can be enabled or disabled. 

 

Display a hint for an enabled toolbar buEon on the message line by moving the mouse over 

the buEon. 

 

The toolbar generally appears below the main menu bar in the root window. The ac/ons for 

these buEons replicate menu items on the Special menu, which also vary depending on the 

applica/on window that is currently ac/ve. Display Oracle Applica�ons Library (the help 

buEon on the toolbar) to learn more about these addi/onal buEons and the Special menu. 

 

 

6.5 TOP 10 LIST OF MOST USED FUNCTIONS 

You have the ability to move 10 frequently used func/ons to the Top Ten List sec/on of the 

navigator to further reduce the number of key strokes required to access them.  

1.  Navigate to (highlight but do not select) the op/on on the navigator that allows you to 

submit requests. The screen below is from one responsibility; yours may look different. 

2. With this op/on highlighted, click the right arrow situated between the two sides of the 

navigator.  
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6.6 DATA ENTRY MODE (AND REQUIRED FIELDS) VS. QUERY MODE 

The Oracle soNware was wriEen in such a way that the same form is oNen used to perform 

data entry and also to query (search) for data previously entered.  

 

By default, when a form first displays, it is in ‘Data Entry’ mode and the fields are coloured 

yellow and white. The fields coloured yellow are required fields and you cannot save the data 

without entering in these fields. The white ones may s/ll be required by Government’s 

procedures, but are not required by the soNware in order to save the data.  

 

If you wish to perform a query, you can either use the shortcut key F11, or use the Menu Bar 

(View � Query by Example� Enter). The fields on the form will then change to blue, which 

indicates you are in ‘Query’ mode. ANer entering search criteria (make use of the ‘%’ wildcard, 

where possible), you can execute the query using the shortcut CTRL+F11, or the Menu Bar 

(View � Query by Example � Run).  

 

If you are having trouble geAng into ‘Query’ mode, it may be because you started to enter 

data, and therefore you will have to clear the record with the shortcut key F6, or the using the 

‘Clear Record’ icon  on the toolbar. 

 

On any form, a field that is shaded in grey, whether it has a value displayed or not, cannot be 

edited in the field itself. It may be possible to change the value elsewhere however. For 

example, on the Submit Request form, the printer name is shaded in grey and therefore 

restricted, but it can s/ll be modified on another form that is displayed aNer clicking on the 

Op/ons buEon. You will see that later in the sec/on on prin/ng. 
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6.7 USING A LIST OF VALUES 

Many fields on forms in the applica/on have a pre-defined set of values. Such fields are 

indicated by a small ‘LOV’ icon (containing 3 dots ) that appears at the end of the field when 

you click in it. An example of one field with this property is the first field you fill in on the 

Submit request form (the name of the report). When you no/ce this icon on a field in IRIS, you 

can proceed in two ways: You can click on the LOV icon to view the en/re list of values in a 

‘Find’ window, or you can type a por/on of the name of the desired report in the field itself, 

using the wildcard character (%) to represent one or more characters. If the text you type does 

not uniquely iden/fy an entry in the list, the 

find screen will display containing only those 

entries that do match the text string as 

entered.  

 

A list of values provides a powerful, easy-to-

use data entry method that increases accuracy 

and produc/vity. It makes data entry an easy 

task for novice users, and power users can 

enter correct data with a minimum number of 

keystrokes. 

 

 

 

Another feature of Oracle Applica/ons that is similar to the LOV and is also designed to save 

/me and reduce typing, is the ‘Find’ feature. When you click in a field and you no/ce that the 

torch (flashlight)  on the Toolbar is illuminated, the field in ques/on allows you to use the 

find feature. This feature can be ac/vated by either clicking on the icon or using the View � 

Find op/on on the Menu Bar. A window similar to that of the LOV will then prompt the user to 

enter a par/al value for the field with ‘%’ reduce the list length, or to enter only the ‘%’ to see 

the en/re list. 

The main difference between the LOV and this Find feature is that the LOV is available mainly 

on fields that the users cannot enter new values in; whereas the Find feature is commonly 

used on fields that the users do enter new data into, such as batch numbers and therefore the 

lists on these are usually very long.   
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7. SUBMITTING REPORTS 

All responsibili/es have access to some type of report(s). The naviga/on path to the Submit 

Requests screen differs from one responsibility to another, but once there, that form itself 

func/ons the same for all responsibili/es. 

The first thing to remember that submiAng a report does not automa/cally mean it will print. 

Unless you click the Op/ons buEon, and change the number of copies from zero (the default) 

to one, it will not print. This is also where you define which printer you want the report to 

print on. 

Un/l you are familiar with the reports you will be using, and how long each generally takes to 

complete, it would be advisable to submit requests with zero copies. The output for each 

request may be viewed online very easily. ANer submiAng, use the Menu Bar and select View 

� Requests. Leave the ‘All my requests’ op/on selected unless you want to specify only 

requests of a certain name, or you know the Request ID of the specific request you want to 

view. 

 

 

 

The next form displays all requests that meet the criteria and their statuses. It is quite possible 

that the most recently submiEed requests have not yet completed. This screen does not 

refresh itself automa/cally, so when monitoring a request, you should click occasionally on the 

‘Refresh Data’ buEon at the top leN of the form.  

 



IRIS 101: A BASIC INTRODUCTION TO IRIS AND ITS NAVIGATION   VER 2.0 

INSTRUCTOR: RICARDO ROACH         13| P a g e  

Once you click on a specific request in the list, and it is a completed request, the ‘View Output’ 

buEon is available.  

 

If you decide to print the report, you should ensure the correct row on the request list is s/ll 

highlighted, and then select the Tools � Reprint/Republish op/on on the Menu Bar. 

 

If a request should complete with a status of ‘Error’ you should click on ‘View Log’ to find the 

text describing the error. If it is unclear to you even aNer reading this, you should contact the 

IRIS Helpdesk for assistance (make note of the request ID and responsibility from which you 

ran the request). They may request that you email them the error message text.  

 

Certain requests in IRIS require that only one request of that type may be run at a �me. If 

your request is in a status of ‘Pending’ it is in the queue to be processed. You can choose 

Tools � Managers � Manager Queue from the Menu Bar to see where your request is in the 

queue.  

 

7.1 SETTING YOUR DEFAULT PRINTER 

To set your default printer in IRIS: 

1. From your Menu Bar choose Edit � Preferences � Profiles to display the Personal Profile 

Values window. 

2. Find the Printer Profile 

2.1. Press F11 on your keyboard (the Profile Name field will now 

be blue),  

2.2. Enter Printer in the Profile Name field 

2.3. Press Ctrl+F11 on your keyboard. 

2.3.1.1. Or 

3. Click on the Flashlight icon and type Printer, select Printer and click 

OK 

4. In the User Value, enter the name of the printer you would like to have as your default 

printer.  

 

In IRIS the printers do not have the ‘NT’ prefix. If you are unable to find your printer in 

the list, email the IRIS Helpdesk with the printer name. 
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7.2 SETTING UP FAVOURITES IN THE ORACLE E-BUSINESS SUITE HTML SCREEN 

To hide responsibili/es you no longer use; 

1. Choose Edit Favorites. 

2. Choose the responsibility that the func/on is 

accessed from. 

3. Enter the Func/on Prompt if you know it and 

search. 

4. Select the func/on(s) that you would like as your 

favourite(s) and choose Add 

5. Repeat this step for other responsibili/es as 

needed. 

6. Click Apply to save your changes, or Cancel to 

disregard them. 

 

You can op�onally change the order in which the favourites are displayed and/or 

change the display name. A good standard to have is to Prefix the prompt with the 

module (e.g. AP, AR, etc), and the organiza�on it access (if you access mul�ple 

organiza�ons). 

 

 

 

 

 

 

 

 

 

7.3 EXITING ORACLE APPLICATIONS 

 

Having completed the work, choose to save or discard any unsaved 

work in the form(s) before exi/ng Oracle. 

From the Menu Bar, choose File � Exit Oracle Applica/ons or click 

on the red ‘X’ ( ) in the top right hand side of your Oracle 

Applica/ons form. If there are no changes to save in the window(s), 

Oracle Applica/ons exits and returns to the desktop. If you have made changes that you want 

to save, choose Save to save the changes before exi/ng. Choose Discard to Exit without saving 

any changes. Choose Cancel to close this window and cancel the exit.  



IRIS 101: A BASIC INTRODUCTION TO IRIS AND ITS NAVIGATION   VER 2.0 

INSTRUCTOR: RICARDO ROACH         15| P a g e  

8. WEB ADI – WEB APPLICATIONS DESKTOP INTEGRATOR 

1. Oracle Web Applica/ons Desktop Integrator brings EBS func/onality to the desktop where the 

familiar MicrosoN applica/ons (such as Excel) can be used to complete your Oracle E-Business Suite 

tasks 

2.  Key Features: 

2.1.  Works Via Internet 

2.2.  Presents Oracle EBS Data in a Spreadsheet Interface 

2.3.  Validates Data 

2.4.  Enables Customiza/ons 

2.5.  Automa/cally Imports Data 

3. WEB ADI integra/on with Excel enables you to bring your data to a spreadsheet where you can 

create formaEed spreadsheets on your desktop allowing you to:  

3.1.  Download, view, edit, and create EBS data 

3.2.  Use data entry shortcuts (copying and pas/ng or dragging and dropping ranges of cells) to save 

/me 

3.3.  Use Excel formulas to calculate amounts 

3.4.  Combine speed and accuracy by invoking lists of values for fields within the spreadsheet 

3.5.  Use Web ADI valida/on func/onality to validate the data before uploading it to IRIS (valida/on 

messages are returned to the spreadsheet, allowing you to iden/fy and correct invalid data) 

4. The task you perform on the desktop is determined by the integrator you select in Web ADI and 

each seeded integrator is delivered with the EBS product that provides the func/onality being 

integrated with the desktop  

5.  Addi/onal informa/on specific to each seeded integrator can be found in the product-specific 

course/documenta/on (only if applicable) 

6.  Please refer to Appendix A (IRIS 101 manual) for addi/onal informa/on on topics related to Web 

ADI: 

6.1.  PC configura/on seAngs required to use Web ADI (internet browser and MicrosoN Excel) 

6.2.  Frequently Asked Ques/ons 
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APPENDIX A 

CLIENT PC CONFIGURATION FOR ORACLE WEB APPLICATIONS DESKTOP INTEGRATOR (WEB 

ADI)            

                         

The main issues are related to the Microsoft Office or the Browsers not configured correctly to 

meet the Web ADI requirements. 

Browser: For the Browsers, to create an Excel spreadsheet on your desktop through Web ADI, 

the 'Initialize and script Active X controls not marked as safe' setting must be set to 'Prompt'.  

This is only defaulted to this value on a 'Low' security setting', therefore you will probably need 

to alter this setting through Internet Explorers Custom Settings option as follows; 

Navigate to IRIS homepage and login (This ensures that correct Internet Explorer security zone 

is configured).  

Select Tools -> Internet Options -> Security tab from the Internet Explorer Menu Bar. Select the 

default security zone (likely Local intranet but it could be Trusted sites) and click the 'Custom 

Level' button. You can then set the value as recommended. 
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Microsoft Excel: Changing Macro Security Settings 

Excel XP/2003 Excel 2007 Excel 2010 

1. In Excel, from the Tools 

menu, select Macro, then 

Security, then Security 

Level. 

2. Select the "Medium" 

option. 

3. Select the Trusted 

Sources tab. 

4. Select the "Trust access 

to Visual Basic Project" 

option. 

1. Click the Office Button (top-

left button in the window) 

2. Click the 'Excel Options' 

button. 

3. Click 'Trust Center' link 

from the menu on the left. 

4. Click 'Trust Center 

Settings...' button. 

5. In the 'Trust Center' 

window click 'Macro Settings' 

link from the menu on the 

left. 

6. Under 'Macro Settings' 

check 'Disable all macros with 

notification'. 

7. Under 'Developer Macro 

Settings' check 'Trust Access 

to the VBA project object 

model'. 

8. Click 'OK' button to close 

the 'Trust Center' window. 

9. Click 'OK' button to return 

to the spreadsheet. 

1. Click File -> Options 

2. Click 'Trust Center' link in 

the 'Excel Options' window. 

3. Click 'Trust Center 

Settings...' button. 

4. In the 'Trust Center' 

window click 'Macro Settings' 

link from the menu on the 

left. 

5. Under 'Macro Settings' 

check 'Disable all macros with 

notification'. 

6. Under 'Developer Macro 

Settings' check 'Trust Access 

to the VBA project object 

model'. 

7. Click 'OK' button to close 

the 'Trust Center' window. 

8. Click 'OK' button to return 

to the spreadsheet. 

 

 



IRIS 101: A BASIC INTRODUCTION TO IRIS AND ITS NAVIGATION   VER 2.0 

INSTRUCTOR: RICARDO ROACH         18| P a g e  

 

 

 

CONGRATULATIONS! 

 

 

YOU HAVE COMPLETED IRIS 101 

INTRODUCTION AND NAVIGATION 

 

 

 

YOU MAY NOW MOVE ONTO IRIS 

PURCHASING 101 


